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PUBLIC NOTICE
FEDERAL COMMUNICATIONS COMMISSION News Media Information: (202) 418-0500

445 12th STREET, S.W. Fax-On-Demand: (202) 418-2830
WASHINGTON, D.C.  20554 Internet: http://www.fcc.gov

ftp.fcc.gov

DA 00-1639
July 24, 2000

AUCTION OF LICENSES FOR
800 MHz SPECIALIZED MOBILE RADIO (SMR) SERVICES

IN THE GENERAL CATEGORY BAND (851-854 MHz)
 AND UPPER BAND (861-865 MHz)

Status of FCC Form 175 Applications to Participate in the Auction

Report No. AUC-34-E  (Auction No. 34)

The Federal Communications Commission ("FCC") has received 31 FCC Form 175 applications
to participate in Auction No. 34 scheduled to begin on Wednesday, August 16, 2000, for 1,053
licenses in the 800 MHz Band.  The applications have been reviewed for completeness and
compliance with the Commission's rules, and have been classified into the following categories:

ACCEPTED FOR FILING.............................................. 12 Applications

INCOMPLETE.................................................................. 19 Applications

Accepted:  Applications accepted for filing are listed in Attachment A.  These applicants will
become qualified bidders upon receipt of the required upfront payment due by 6:00 p.m.
ET on Monday, July 31, 2000.1  With respect to the FCC Form 175 applications, these
applicants need take no further action except as may be necessary to maintain the accuracy of
their applications.2  Also, applicants are advised that Attachment A includes FCC account
numbers that were automatically created by the FCC software system for each applicant, and
which are applicable for bidding only.
                                                
    1 See  47 C.F.R. § 1.2106.

     2 See 47 C.F.R. § 1.65.

http://www.fcc.gov/
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Incomplete:  Applications found to be incomplete are listed alphabetically in Attachment B.
Applicants whose FCC Form 175 applications have been deemed incomplete will receive
overnight correspondence indicating what information is required to make the applications
acceptable for filing.  These applicants may become qualified bidders only if they:  (1)
resubmit their applications by 6:00 p.m. ET on Monday, July 31, 2000, to correct the minor
deficiencies indicated; and (2) make the required upfront payments by 6:00 p.m. ET on
Monday, July 31, 2000.  Applicants must also maintain the accuracy of their FCC Form 175
applications as required by the Commission’s rules.3  In addition, applicants are advised that
Attachment B includes FCC account numbers that were automatically created by the FCC
software system for each applicant.  These account numbers are applicable for bidding purposes
only, should the applicant become eligible to participate in Auction No. 34.

The filing window for resubmitting FCC Form 175 applications is now open. Corrected
applications must be filed no later than 6:00 p.m. ET on Monday, July 31, 2000.  This will be
the only opportunity to cure FCC Form 175 defects; late resubmissions will not be accepted.   In
addition, if an application remains incomplete or otherwise deficient after the resubmission
deadline has passed, the application will be rejected.

UPFRONT PAYMENT DEADLINE

Upfront payments and accompanying FCC Remittance Advice (FCC Form 159) for Auction No.
34 are due at Mellon Bank, Pittsburgh, Pennsylvania, by 6:00 p.m. ET on Monday, July 31,
2000.  Payments must be made by wire transfer and applicants must include their Taxpayer
Identification Numbers (TIN).  No other payment method is acceptable for this auction.4

Applicants are reminded to use their TIN and not their FCC Account Numbers on the FCC
Remittance Advice (FCC Form 159).

Applicants that have filed applications deemed to be incomplete, as noted in this public
notice, must submit timely and sufficient upfront payments before the Commission will
review their resubmitted applications.  If such an application remains incomplete following its
resubmission, the application will be dismissed.  If the applicant has provided its Taxpayer
Identification Number (TIN) and wire transfer instructions, the upfront payment will be refunded
automatically.

OTHER IMPORTANT INFORMATION

Internet Access and Filing:  Effective Monday, July 17, 2000, the Bureau permitted the filing
of FCC Form 175 via the Internet.  As a result, two of the attachments previously provided in the
Auction No. 34 Announcing Public Notice have been updated.5  Specifically, the Bureau has

                                                
3 Id.

 4 Id.

5 See "Auction of Licenses for 800 MHz Specialized Mobile Radio (SMR) Service in the General Category
Band (851-854 MHz) and Upper Band (861-865 MHz); Auction Notice and Filing Requirements for 1,053 Licenses
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amended Attachment C and Attachment H.  The amended attachments are included in this public
notice as Attachment C and D.

Qualified Bidders:  Approximately one week after upfront payments have been received,
resubmitted FCC Form 175 applications have been processed and reviewed, and payments and
applications have been correlated, a public notice listing all applicants qualified to bid in the
auction will be released.  The same public notice will also include instructions on how to access
the auction tracking tool software, a bidding schedule for the Mock auction, and the bidding
schedule for the first day of the auction.

Prohibition of Collusion:  Bidders are reminded that Section 1.2105(c) of the Commission's
Rules prohibits applicants for the same geographic license area from communicating with each
other during the auction about bids, bidding strategies, or settlements unless they have identified
each other as parties with whom they have entered into agreements under Section
1.2105(a)(2)(viii).  For Auction No. 34, this prohibition became effective at the filing deadline of
short-form applications on Monday, July 17, 2000, and will end on the post-auction down
payment due date.  The post-auction down payment due date will be announced in a future
public notice.  If parties had agreed in principle on all material terms, those parties must have
been identified on the short-form application under Section 1.2105(c), even if the agreement had
not been reduced to writing.  If parties had not agreed in principle by the filing deadline, an
applicant should not have included the names of those parties on its application, and must not
have continued negotiations with other applicants for licenses in the same geographic area.6  For
further details regarding the prohibition against collusion refer to the Auction No. 34 Announcing
Public Notice.

In addition, applicants are reminded that they are subject to the antitrust laws, which are
designed to prevent anti-competitive behavior in the marketplace.  Winning bidders will be
required to disclose in their long-form applications the specific terms, conditions and parties
involved in all bidding consortia, joint ventures, partnerships, and other arrangements entered
into relating to the competitive bidding process.  Bidders found to have violated the anti-
collusion rule may be subject to sanctions.7

Ex Parte Rule:  Applicants should also be aware that the Commission has generally exempted
auction proceedings from the strict requirements of the ex parte rule found in Section 1.21088 of
the Commission’s rules.9

                                                                                                                                                            
in the 800 MHz SMR Service for the General Category Auction; Auction Rescheduled from August 23, 2000 to
August 16, 2000; Minimum Opening Bids and Other Procedural Issues," Public Notice, DA 00-1100 (rel. May 18,
2000) (“Auction No. 34 Announcing Public Notice”) for detailed remittance and upfront payment information.  This
and other documents are available on the FCC website at:  http://www.fcc.gov/wtb/auctions.

6 “Wireless Telecommunications Bureau Clarifies Spectrum Auction Anti-Collusion Rules,” Public Notice,
DA 95-2244 (rel. October 26, 1995), 11 FCC Rcd 9645 (1995).

7 See 47 C.F.R. §§ 1.2105(c), 1.2107(d), and 1.2109(d).

8 47 C.F.R. §1.2108.
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Mock Auction:  All applicants found to be qualified bidders are eligible to participate in a mock
electronic auction on Monday, August 14, 2000.  In the Qualified Bidders Public Notice, the
Bureau will announce when software for the mock auction will be posted on the World Wide
Web.

Remote Bidding Software:  Applicants are reminded that qualified bidders are eligible to bid
either electronically or telephonically.  To bid electronically, applicants should complete the
software order form included in the Auction No. 34 Announcing Public Notice or contact the
Auctions Hotline at (717) 338-2888.  To ensure timely delivery of remote bidding software
before the auction begins, the Commission requests receipt of software orders by 5:30 p.m. ET
on Tuesday, August 1, 2000.  The minimum hardware and software specifications required for
the FCC remote bidding system are listed below:

•  CPU: Intel ® Pentium or above
•  RAM: 16 MB (more recommended if you have multiple applications open)
•  Hard Disk: 33 MB available disk space
•  1.44 MB Floppy Drive or CD-ROM Drive (to install the Remote Bidding System)
•  Modem: v.32bis 28.8 kbps Hayes© compatible modem (56.6 kbps recommended)
•  Monitor: VGA or above
•  Mouse or other pointing device
•  Microsoft® Windows™ 95™ or 98™
•  We recommend that you use Netscape® Communicator™ 4.73.  However, you can also use

Netscape Communicator 4.7 or 4.72.

To download Netscape Communicator 4.73 free of charge, access the Netscape
download site at http://home.netscape.com/download/

Note:  The FCC Remote Bidding System has not been tested in a Macintosh, OS/2, or Windows
NT™ environment.  Therefore, the FCC will not support operating systems other than Microsoft
Windows 95 or 98.  This includes any other emulated Windows environment.

Long-Form Applications:  All applicants should be aware that at the long-form application
stage, they will be subject to the more extensive reporting requirements contained in the
Commission's Part 1 ownership disclosure rule.10

Bidder Alerts:   All applicants must certify on their FCC Form 175 applications under penalty
of perjury that they are legally, technically, financially and otherwise qualified to hold a license,
and not in default on any payment for Commission licenses (including down payments) or

                                                                                                                                                            
9  See 47 C.F.R. §1.202(d) note (1); see also “Commission Announces that Mutually Exclusive ‘Short-Form’
Applications (Form 175) to Participate in Competitive Bidding Process (‘Auctions’) Are Treated as Exempt for Ex
Parte Purposes,” Public Notice, 9 FCC Rcd 6760 (1994).

     10 See 47 C.F.R. § 1.2112(b).
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delinquent on any non-tax debt owed to any Federal agency.  Prospective bidders are reminded
that submission of a false certification to the Commission is a serious matter that may result in
severe penalties, including monetary forfeitures, license revocations, exclusion from
participation in future auctions, and/or criminal prosecution.

Information about deceptive telemarketing investment schemes is available from the FTC at
(202) 326-2222 and from the SEC at (202) 942-7040.  Complaints about specific deceptive
telemarketing investment schemes should be directed to the FTC, the SEC, or the National Fraud
Information Center at (800) 876-7060.  Consumers who have concerns about specific proposals
may also call the FCC National Call Center at (888) CALL-FCC ((888) 225-5322).
*       *       *       *       *

For questions about payment or instructions for wiring upfront payments, contact Gail Glasser or
Michelle Bennett, Auctions Accounting Group, at (202) 418-1995.

For specific questions about an applicant's incomplete status, the applicant should contact the
staff attorney identified in the correspondence sent to the applicant by overnight mail.

For additional information, contact:  M. Nicole Oden, Auctions Legal Branch at (202) 418-0660
(regarding legal questions); Linda Sanderson, Auctions Operations (regarding bidding and
general filing status) or Bob Reagle, Analyst, Auctions Operations (regarding bidding) at (717)
338-2888.

- FCC –



FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0341410075 A.R.C., Inc.  

The following License(s):

ALL

0341241545 Arthur Patrick  

The following License(s):

BEA125-D BEA125-DD BEA125-E BEA125-EE BEA125-F BEA125-FF BEA126-D BEA126-DD BEA126-E BEA126-EE

BEA126-F BEA126-FF

0341611285 Centre Communications, Inc.  

The following License(s):

BEA009-D BEA009-DD BEA009-E BEA009-EE BEA009-F BEA009-FF BEA011-D BEA011-DD BEA011-E BEA011-EE

BEA011-F BEA011-FF

0341421533 Electronic Maintenance Co., Inc.  

The following License(s):

BEA084-D BEA084-DD BEA084-E BEA084-EE BEA084-F BEA084-FF

0340202405 L.P. Ganacias Enterprises, Inc.  

The following License(s):

ALL

0340316286 Linda Sue and Herschel Bruce Williamson  

The following License(s):

ALL A

ALL B

ALL C

BEA002-D BEA002-DD BEA002-E BEA002-EE BEA002-F BEA002-FF BEA003-D BEA003-DD BEA003-E BEA003-EE

BEA003-F BEA003-FF BEA004-D BEA004-DD BEA004-E BEA004-EE BEA004-F BEA004-FF BEA005-D BEA005-DD

BEA005-E BEA005-EE BEA005-F BEA005-FF BEA006-D BEA006-DD BEA006-E BEA006-EE BEA006-F BEA006-FF

BEA007-D BEA007-DD BEA007-E BEA007-EE BEA007-F BEA007-FF BEA008-D BEA008-DD BEA008-E BEA008-EE

BEA008-F BEA008-FF BEA009-D BEA009-DD BEA009-E BEA009-EE BEA009-F BEA009-FF BEA010-D BEA010-DD

BEA010-E BEA010-EE BEA010-F BEA010-FF BEA011-D BEA011-DD BEA011-E BEA011-EE BEA011-F BEA011-FF

BEA012-D BEA012-DD BEA012-E BEA012-EE BEA012-F BEA012-FF BEA013-D BEA013-DD BEA013-E BEA013-EE

BEA013-F BEA013-FF BEA014-D BEA014-DD BEA014-E BEA014-EE BEA014-F BEA014-FF BEA015-D BEA015-DD
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FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0340316286 Linda Sue and Herschel Bruce Williamson  

The following License(s):

BEA015-E BEA015-EE BEA015-F BEA015-FF BEA016-D BEA016-DD BEA016-E BEA016-EE BEA016-F BEA016-FF

BEA017-D BEA017-DD BEA017-E BEA017-EE BEA017-F BEA017-FF BEA018-D BEA018-DD BEA018-E BEA018-EE

BEA018-F BEA018-FF BEA019-D BEA019-DD BEA019-E BEA019-EE BEA019-F BEA019-FF BEA020-D BEA020-DD

BEA020-E BEA020-EE BEA020-F BEA020-FF BEA021-D BEA021-DD BEA021-E BEA021-EE BEA021-F BEA021-FF

BEA022-D BEA022-DD BEA022-E BEA022-EE BEA022-F BEA022-FF BEA023-D BEA023-DD BEA023-E BEA023-EE

BEA023-F BEA023-FF BEA024-D BEA024-DD BEA024-E BEA024-EE BEA024-F BEA024-FF BEA025-D BEA025-DD

BEA025-E BEA025-EE BEA025-F BEA025-FF BEA026-D BEA026-DD BEA026-E BEA026-EE BEA026-F BEA026-FF

BEA027-D BEA027-DD BEA027-E BEA027-EE BEA027-F BEA027-FF BEA028-D BEA028-DD BEA028-E BEA028-EE

BEA028-F BEA028-FF BEA029-D BEA029-DD BEA029-E BEA029-EE BEA029-F BEA029-FF BEA030-D BEA030-DD

BEA030-E BEA030-EE BEA030-F BEA030-FF BEA031-D BEA031-DD BEA031-E BEA031-EE BEA031-F BEA031-FF

BEA032-D BEA032-DD BEA032-E BEA032-EE BEA032-F BEA032-FF BEA033-D BEA033-DD BEA033-E BEA033-EE

BEA033-F BEA033-FF BEA034-D BEA034-DD BEA034-E BEA034-EE BEA034-F BEA034-FF BEA035-D BEA035-DD

BEA035-E BEA035-EE BEA035-F BEA035-FF BEA036-D BEA036-DD BEA036-E BEA036-EE BEA036-F BEA036-FF

BEA037-D BEA037-DD BEA037-E BEA037-EE BEA037-F BEA037-FF BEA038-D BEA038-DD BEA038-E BEA038-EE

BEA038-F BEA038-FF BEA039-D BEA039-DD BEA039-E BEA039-EE BEA039-F BEA039-FF BEA040-D BEA040-DD

BEA040-E BEA040-EE BEA040-F BEA040-FF BEA041-D BEA041-DD BEA041-E BEA041-EE BEA041-F BEA041-FF

BEA042-D BEA042-DD BEA042-E BEA042-EE BEA042-F BEA042-FF BEA043-D BEA043-DD BEA043-E BEA043-EE

BEA043-F BEA043-FF BEA044-D BEA044-DD BEA044-E BEA044-EE BEA044-F BEA044-FF BEA045-D BEA045-DD

BEA045-E BEA045-EE BEA045-F BEA045-FF BEA046-D BEA046-DD BEA046-E BEA046-EE BEA046-F BEA046-FF

BEA047-D BEA047-DD BEA047-E BEA047-EE BEA047-F BEA047-FF BEA048-D BEA048-DD BEA048-E BEA048-EE

BEA048-F BEA048-FF BEA049-D BEA049-DD BEA049-E BEA049-EE BEA049-F BEA049-FF BEA050-D BEA050-DD

BEA050-E BEA050-EE BEA050-F BEA050-FF BEA051-D BEA051-DD BEA051-E BEA051-EE BEA051-F BEA051-FF

BEA052-D BEA052-DD BEA052-E BEA052-EE BEA052-F BEA052-FF BEA053-D BEA053-DD BEA053-E BEA053-EE

BEA053-F BEA053-FF BEA054-D BEA054-DD BEA054-E BEA054-EE BEA054-F BEA054-FF BEA055-D BEA055-DD

BEA055-E BEA055-EE BEA055-F BEA055-FF BEA056-D BEA056-DD BEA056-E BEA056-EE BEA056-F BEA056-FF

BEA057-D BEA057-DD BEA057-E BEA057-EE BEA057-F BEA057-FF BEA058-D BEA058-DD BEA058-E BEA058-EE

BEA058-F BEA058-FF BEA059-D BEA059-DD BEA059-E BEA059-EE BEA059-F BEA059-FF BEA060-D BEA060-DD

BEA060-E BEA060-EE BEA060-F BEA060-FF BEA061-D BEA061-DD BEA061-E BEA061-EE BEA061-F BEA061-FF

BEA062-D BEA062-DD BEA062-E BEA062-EE BEA062-F BEA062-FF BEA063-D BEA063-DD BEA063-E BEA063-EE

BEA063-F BEA063-FF BEA064-D BEA064-DD BEA064-E BEA064-EE BEA064-F BEA064-FF BEA065-D BEA065-DD

BEA065-E BEA065-EE BEA065-F BEA065-FF BEA066-D BEA066-DD BEA066-E BEA066-EE BEA066-F BEA066-FF

BEA067-D BEA067-DD BEA067-E BEA067-EE BEA067-F BEA067-FF BEA068-D BEA068-DD BEA068-E BEA068-EE
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FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0340316286 Linda Sue and Herschel Bruce Williamson  

The following License(s):

BEA068-F BEA068-FF BEA069-D BEA069-DD BEA069-E BEA069-EE BEA069-F BEA069-FF BEA070-D BEA070-DD

BEA070-E BEA070-EE BEA070-F BEA070-FF BEA071-D BEA071-DD BEA071-E BEA071-EE BEA071-F BEA071-FF

BEA072-D BEA072-DD BEA072-E BEA072-EE BEA072-F BEA072-FF BEA073-D BEA073-DD BEA073-E BEA073-EE

BEA073-F BEA073-FF BEA074-D BEA074-DD BEA074-E BEA074-EE BEA074-F BEA074-FF BEA075-D BEA075-DD

BEA075-E BEA075-EE BEA075-F BEA075-FF BEA076-D BEA076-DD BEA076-E BEA076-EE BEA076-F BEA076-FF

BEA077-D BEA077-DD BEA077-E BEA077-EE BEA077-F BEA077-FF BEA078-D BEA078-DD BEA078-E BEA078-EE

BEA078-F BEA078-FF BEA079-D BEA079-DD BEA079-E BEA079-EE BEA079-F BEA079-FF BEA080-D BEA080-DD

BEA080-E BEA080-EE BEA080-F BEA080-FF BEA081-D BEA081-DD BEA081-E BEA081-EE BEA081-F BEA081-FF

BEA082-D BEA082-DD BEA082-E BEA082-EE BEA082-F BEA082-FF BEA083-D BEA083-DD BEA083-E BEA083-EE

BEA083-F BEA083-FF BEA084-D BEA084-DD BEA084-E BEA084-EE BEA084-F BEA084-FF BEA085-D BEA085-DD

BEA085-E BEA085-EE BEA085-F BEA085-FF BEA086-D BEA086-DD BEA086-E BEA086-EE BEA086-F BEA086-FF

BEA087-D BEA087-DD BEA087-E BEA087-EE BEA087-F BEA087-FF BEA088-D BEA088-DD BEA088-E BEA088-EE

BEA088-F BEA088-FF BEA089-D BEA089-DD BEA089-E BEA089-EE BEA089-F BEA089-FF BEA090-D BEA090-DD

BEA090-E BEA090-EE BEA090-F BEA090-FF BEA091-D BEA091-DD BEA091-E BEA091-EE BEA091-F BEA091-FF

BEA092-D BEA092-DD BEA092-E BEA092-EE BEA092-F BEA092-FF BEA093-D BEA093-DD BEA093-E BEA093-EE

BEA093-F BEA093-FF BEA094-D BEA094-DD BEA094-E BEA094-EE BEA094-F BEA094-FF BEA095-D BEA095-DD

BEA095-E BEA095-EE BEA095-F BEA095-FF BEA096-D BEA096-DD BEA096-E BEA096-EE BEA096-F BEA096-FF

BEA097-D BEA097-DD BEA097-E BEA097-EE BEA097-F BEA097-FF BEA098-D BEA098-DD BEA098-E BEA098-EE

BEA098-F BEA098-FF BEA099-D BEA099-DD BEA099-E BEA099-EE BEA099-F BEA099-FF BEA100-D BEA100-DD

BEA100-E BEA100-EE BEA100-F BEA100-FF BEA101-D BEA101-DD BEA101-E BEA101-EE BEA101-F BEA101-FF

BEA102-D BEA102-DD BEA102-E BEA102-EE BEA102-F BEA102-FF BEA103-D BEA103-DD BEA103-E BEA103-EE

BEA103-F BEA103-FF BEA104-D BEA104-DD BEA104-E BEA104-EE BEA104-F BEA104-FF BEA105-D BEA105-DD

BEA105-E BEA105-EE BEA105-F BEA105-FF BEA106-D BEA106-DD BEA106-E BEA106-EE BEA106-F BEA106-FF

BEA107-D BEA107-DD BEA107-E BEA107-EE BEA107-F BEA107-FF BEA108-D BEA108-DD BEA108-E BEA108-EE

BEA108-F BEA108-FF BEA109-D BEA109-DD BEA109-E BEA109-EE BEA109-F BEA109-FF BEA110-D BEA110-DD

BEA110-E BEA110-EE BEA110-F BEA110-FF BEA111-D BEA111-DD BEA111-E BEA111-EE BEA111-F BEA111-FF

BEA112-D BEA112-DD BEA112-E BEA112-EE BEA112-F BEA112-FF BEA113-D BEA113-DD BEA113-E BEA113-EE

BEA113-F BEA113-FF BEA114-D BEA114-DD BEA114-E BEA114-EE BEA114-F BEA114-FF BEA115-D BEA115-DD

BEA115-E BEA115-EE BEA115-F BEA115-FF BEA116-D BEA116-DD BEA116-E BEA116-EE BEA116-F BEA116-FF

BEA117-D BEA117-DD BEA117-E BEA117-EE BEA117-F BEA117-FF BEA118-D BEA118-DD BEA118-E BEA118-EE

BEA118-F BEA118-FF BEA119-D BEA119-DD BEA119-E BEA119-EE BEA119-F BEA119-FF BEA120-D BEA120-DD

BEA120-E BEA120-EE BEA120-F BEA120-FF BEA121-D BEA121-DD BEA121-E BEA121-EE BEA121-F BEA121-FF
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FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0340316286 Linda Sue and Herschel Bruce Williamson  

The following License(s):

BEA122-D BEA122-DD BEA122-E BEA122-EE BEA122-F BEA122-FF BEA123-D BEA123-DD BEA123-E BEA123-EE

BEA123-F BEA123-FF BEA124-D BEA124-DD BEA124-E BEA124-EE BEA124-F BEA124-FF BEA125-D BEA125-DD

BEA125-E BEA125-EE BEA125-F BEA125-FF BEA126-D BEA126-DD BEA126-E BEA126-EE BEA126-F BEA126-FF

BEA127-D BEA127-DD BEA127-E BEA127-EE BEA127-F BEA127-FF BEA128-D BEA128-DD BEA128-E BEA128-EE

BEA128-F BEA128-FF BEA129-D BEA129-DD BEA129-E BEA129-EE BEA129-F BEA129-FF BEA130-D BEA130-DD

BEA130-E BEA130-EE BEA130-F BEA130-FF BEA131-D BEA131-DD BEA131-E BEA131-EE BEA131-F BEA131-FF

BEA132-D BEA132-DD BEA132-E BEA132-EE BEA132-F BEA132-FF BEA133-D BEA133-DD BEA133-E BEA133-EE

BEA133-F BEA133-FF BEA134-D BEA134-DD BEA134-E BEA134-EE BEA134-F BEA134-FF BEA135-D BEA135-DD

BEA135-E BEA135-EE BEA135-F BEA135-FF BEA136-D BEA136-DD BEA136-E BEA136-EE BEA136-F BEA136-FF

BEA137-D BEA137-DD BEA137-E BEA137-EE BEA137-F BEA137-FF BEA138-D BEA138-DD BEA138-E BEA138-EE

BEA138-F BEA138-FF BEA139-D BEA139-DD BEA139-E BEA139-EE BEA139-F BEA139-FF BEA140-D BEA140-DD

BEA140-E BEA140-EE BEA140-F BEA140-FF BEA141-D BEA141-DD BEA141-E BEA141-EE BEA141-F BEA141-FF

BEA142-D BEA142-DD BEA142-E BEA142-EE BEA142-F BEA142-FF BEA143-D BEA143-DD BEA143-E BEA143-EE

BEA143-F BEA143-FF BEA144-D BEA144-DD BEA144-E BEA144-EE BEA144-F BEA144-FF BEA145-D BEA145-DD

BEA145-E BEA145-EE BEA145-F BEA145-FF BEA146-D BEA146-DD BEA146-E BEA146-EE BEA146-F BEA146-FF

BEA147-D BEA147-DD BEA147-E BEA147-EE BEA147-F BEA147-FF BEA148-D BEA148-DD BEA148-E BEA148-EE

BEA148-F BEA148-FF BEA149-D BEA149-DD BEA149-E BEA149-EE BEA149-F BEA149-FF BEA150-D BEA150-DD

BEA150-E BEA150-EE BEA150-F BEA150-FF BEA151-D BEA151-DD BEA151-E BEA151-EE BEA151-F BEA151-FF

BEA152-D BEA152-DD BEA152-E BEA152-EE BEA152-F BEA152-FF BEA153-D BEA153-DD BEA153-E BEA153-EE

BEA153-F BEA153-FF BEA154-D BEA154-DD BEA154-E BEA154-EE BEA154-F BEA154-FF BEA155-D BEA155-DD

BEA155-E BEA155-EE BEA155-F BEA155-FF BEA156-D BEA156-DD BEA156-E BEA156-EE BEA156-F BEA156-FF

BEA157-D BEA157-DD BEA157-E BEA157-EE BEA157-F BEA157-FF BEA158-D BEA158-DD BEA158-E BEA158-EE

BEA158-F BEA158-FF BEA159-D BEA159-DD BEA159-E BEA159-EE BEA159-F BEA159-FF BEA160-D BEA160-DD

BEA160-E BEA160-EE BEA160-F BEA160-FF BEA161-D BEA161-DD BEA161-E BEA161-EE BEA161-F BEA161-FF

BEA162-D BEA162-DD BEA162-E BEA162-EE BEA162-F BEA162-FF BEA163-D BEA163-DD BEA163-E BEA163-EE

BEA163-F BEA163-FF BEA164-D BEA164-DD BEA164-E BEA164-EE BEA164-F BEA164-FF BEA165-D BEA165-DD

BEA165-E BEA165-EE BEA165-F BEA165-FF BEA166-D BEA166-DD BEA166-E BEA166-EE BEA166-F BEA166-FF

BEA167-D BEA167-DD BEA167-E BEA167-EE BEA167-F BEA167-FF BEA168-D BEA168-DD BEA168-E BEA168-EE

BEA168-F BEA168-FF BEA169-D BEA169-DD BEA169-E BEA169-EE BEA169-F BEA169-FF BEA170-D BEA170-DD

BEA170-E BEA170-EE BEA170-F BEA170-FF BEA171-D BEA171-DD BEA171-E BEA171-EE BEA171-F BEA171-FF

BEA172-D BEA172-DD BEA172-E BEA172-EE BEA172-F BEA172-FF BEA173-D BEA173-DD BEA173-E BEA173-EE

BEA173-F BEA173-FF BEA174-D BEA174-DD BEA174-E BEA174-EE BEA174-F BEA174-FF BEA175-D BEA175-DD
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FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0340316286 Linda Sue and Herschel Bruce Williamson  

The following License(s):

BEA175-E BEA175-EE BEA175-F BEA175-FF

0341431182 MilkyWay Data Services, Inc.  

The following License(s):

ALL

0340805453 Pacific Wireless Technologies, Inc.  

The following License(s):

ALL A

BEA115-D BEA115-DD BEA115-E BEA115-EE BEA115-F BEA115-FF BEA127-D BEA127-DD BEA127-E BEA127-EE

BEA127-F BEA127-FF BEA128-D BEA128-DD BEA128-E BEA128-EE BEA128-F BEA128-FF BEA129-D BEA129-DD

BEA129-E BEA129-EE BEA129-F BEA129-FF BEA130-D BEA130-DD BEA130-E BEA130-EE BEA130-F BEA130-FF

BEA131-D BEA131-DD BEA131-E BEA131-EE BEA131-F BEA131-FF BEA132-D BEA132-DD BEA132-E BEA132-EE

BEA132-F BEA132-FF BEA133-D BEA133-DD BEA133-E BEA133-EE BEA133-F BEA133-FF BEA134-D BEA134-DD

BEA134-E BEA134-EE BEA134-F BEA134-FF BEA135-D BEA135-DD BEA135-E BEA135-EE BEA135-F BEA135-FF

BEA136-D BEA136-DD BEA136-E BEA136-EE BEA136-F BEA136-FF BEA137-D BEA137-DD BEA137-E BEA137-EE

BEA137-F BEA137-FF BEA138-D BEA138-DD BEA138-E BEA138-EE BEA138-F BEA138-FF BEA139-D BEA139-DD

BEA139-E BEA139-EE BEA139-F BEA139-FF BEA140-D BEA140-DD BEA140-E BEA140-EE BEA140-F BEA140-FF

BEA141-D BEA141-DD BEA141-E BEA141-EE BEA141-F BEA141-FF BEA142-D BEA142-DD BEA142-E BEA142-EE

BEA142-F BEA142-FF BEA143-D BEA143-DD BEA143-E BEA143-EE BEA143-F BEA143-FF BEA144-D BEA144-DD

BEA144-E BEA144-EE BEA144-F BEA144-FF BEA145-D BEA145-DD BEA145-E BEA145-EE BEA145-F BEA145-FF

BEA146-D BEA146-DD BEA146-E BEA146-EE BEA146-F BEA146-FF BEA147-D BEA147-DD BEA147-E BEA147-EE

BEA147-F BEA147-FF BEA148-D BEA148-DD BEA148-E BEA148-EE BEA148-F BEA148-FF BEA149-D BEA149-DD

BEA149-E BEA149-EE BEA149-F BEA149-FF BEA150-D BEA150-DD BEA150-E BEA150-EE BEA150-F BEA150-FF

BEA151-D BEA151-DD BEA151-E BEA151-EE BEA151-F BEA151-FF BEA152-D BEA152-DD BEA152-E BEA152-EE

BEA152-F BEA152-FF BEA153-D BEA153-DD BEA153-E BEA153-EE BEA153-F BEA153-FF BEA154-D BEA154-DD

BEA154-E BEA154-EE BEA154-F BEA154-FF BEA155-D BEA155-DD BEA155-E BEA155-EE BEA155-F BEA155-FF

BEA156-D BEA156-DD BEA156-E BEA156-EE BEA156-F BEA156-FF BEA157-D BEA157-DD BEA157-E BEA157-EE

BEA157-F BEA157-FF BEA158-D BEA158-DD BEA158-E BEA158-EE BEA158-F BEA158-FF BEA159-D BEA159-DD

BEA159-E BEA159-EE BEA159-F BEA159-FF BEA160-D BEA160-DD BEA160-E BEA160-EE BEA160-F BEA160-FF

BEA161-D BEA161-DD BEA161-E BEA161-EE BEA161-F BEA161-FF BEA162-D BEA162-DD BEA162-E BEA162-EE

BEA162-F BEA162-FF BEA163-D BEA163-DD BEA163-E BEA163-EE BEA163-F BEA163-FF BEA164-D BEA164-DD

BEA164-E BEA164-EE BEA164-F BEA164-FF BEA165-D BEA165-DD BEA165-E BEA165-EE BEA165-F BEA165-FF

Page 5 of 6Page 5 of 6



FCC 800 MHz SMR General Category Auction
Form 175 Accepted List (Initial)
Auction ID: 34

FCC Account # Name Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT A

The following Form 175 Applicants have been judged 'Acceptable' and have applied for the following licenses:

0340805453 Pacific Wireless Technologies, Inc.  

The following License(s):

BEA166-D BEA166-DD BEA166-E BEA166-EE BEA166-F BEA166-FF BEA167-D BEA167-DD BEA167-E BEA167-EE

BEA167-F BEA167-FF BEA168-D BEA168-DD BEA168-E BEA168-EE BEA168-F BEA168-FF BEA169-D BEA169-DD

BEA169-E BEA169-EE BEA169-F BEA169-FF BEA170-D BEA170-DD BEA170-E BEA170-EE BEA170-F BEA170-FF

BEA171-D BEA171-DD BEA171-E BEA171-EE BEA171-F BEA171-FF BEA172-D BEA172-DD BEA172-E BEA172-EE

BEA172-F BEA172-FF

0341153388 Southern Communications Services, Inc  

The following License(s):

ALL

0341658169 SUPREME RADIO COMMUNICATIONS, INC.  

The following License(s):

BEA101-D BEA101-DD BEA101-E BEA101-EE BEA101-F BEA101-FF BEA102-D BEA102-DD BEA102-E BEA102-EE

BEA102-F BEA102-FF BEA103-D BEA103-DD BEA103-E BEA103-EE BEA103-F BEA103-FF

0341055115 Western Communications, Inc.  

The following License(s):

ALL

0340936327 Winsome Paging Inc.  

The following License(s):

ALL

Page 6 of 6Page 6 of 6



FCC 800 MHz SMR General Category Auction
Form 175 Incomplete List (Initial)
Auction ID: 34

The following entries have been found to be deficient in completing their Form 175 for the following reasons:

FCC Account # Name Error Description Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT B

0341833066 Alpha Wireless Communications Co.  

Invalid Attachments

0341333186 Capital Digitronics, Inc.  

Invalid Attachments

0341532147 Choice Phone LLC  

Invalid Attachments

0341000492 Communication Specialists Inc.  

Invalid Attachments

0341657023 Communications Equipment, Inc.  

Invalid Attachments

0341515013 Florida SMR Partners  

Invalid Attachments

0341202199 Hawaiian Wireless, Inc.  

Invalid Attachments

0341633147 High Tech Communication Services, Inc  

Invalid Attachments

0341713381 Island SMR, Inc.  

Invalid Attachments

0341737313 Mobile Relay Associates  

Invalid Attachments

0341741318 Motient Communications Company  

Invalid Attachments
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FCC 800 MHz SMR General Category Auction
Form 175 Incomplete List (Initial)
Auction ID: 34

The following entries have been found to be deficient in completing their Form 175 for the following reasons:

FCC Account # Name Error Description Waiver Requested

(Sorted by Applicant)(Sorted by Applicant)

Date of Report: 7/21/007/21/00

ATTACHMENT B

0341215027 Nevada Wireless LLC  

Invalid Attachments

0341142202 Nextel Spectrum Acquisition Corp.  

Invalid Attachments

0341645496 North Sight Communications, Inc.  

Invalid Attachments

0341843435 Preferred Acquisitions Inc  

Invalid Attachments

0341242196 Silver Palm Communications, Inc.  

Invalid Attachments

0341352122 Southern Media, Inc.  

Invalid Attachments

0341353203 Stateline Broadcasting, Inc  

Invalid Attachments

0341615217 Stone's Mobile Radio, Inc.  

Invalid Attachments

Page 2 of 2Page 2 of 2
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ATTACHMENT C

ELECTRONIC FILING AND REVIEW
OF THE FCC FORM 175

Applicants must submit their FCC Form 175 applications electronically, using either the FCC
Auctions System page on the Internet or the Commission's remote access system.  The remote
access system will generally be available 24 hours per day.  FCC Form 175 applications must be
resubmitted and confirmed by 6:00 p.m. ET on Monday, July 31, 2000.  Late resubmissions
will not be accepted. 

The electronic filing process consists of an initial filing period and a resubmission period to
make minor corrections.  During this resubmission window, applications may be updated and
amended multiple times until the filing deadline.

A. Minimum Hardware and Software Requirements

Applicants will need to meet the following minimum hardware and software requirements:

1. Minimum Hardware Requirements

•  CPU:  Intel Pentium
•  RAM: 16 MB (more recommended if you have multiple applications open)
•  Modem:  28.8 Kbps Hayes compatible modem or faster (recommend 56.6 Kbps)
•  Monitor:  VGA or above
•  Mouse or other pointing device

2. Minimum Software Requirements

•  Operating System: Microsoft Windows 95 or 98

•  Web Browser:  Netscape Communicator 4.73 is recommended.  However, you can also use
Netscape Communicator 4.5, 4.51, 4.61, 4.7, or 4.72 (Internet web browser software).

Note:  To download Netscape Communicator 4.73 free of charge, access the Netscape
download site at http://home.netscape.com/download/

•  PDF Viewer:  Adobe Acrobat Reader 3.0 or higher (available at http://www.adobe.com)

•  If you wish to use the download feature in the Form 175 Review, you will need a .tar file
extraction utility, e.g., Winzip (available at http://www.winzip.com) or Pkzip for Windows
(available at http://www.pkware.com/download.html).
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B. Resubmitting FCC Form 175 Applications

You can resubmit FCC Form 175 applications electronically via the Internet.  Start your Netscape
Web browser.  In your browser’s Location field, enter http://wtbwww15.fcc.gov and then click
175 Submit.

Note:  If you have problems with the Internet, you may submit FCC Form 175
applications via the FCC Wide-Area Network, using Dial-Up Networking.  For details,
refer to the Accessing the FCC Network to File FCC Form 175 attachment.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of file
formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII text -
- and should verify that the files contain all exhibit information.  Graphics file uploads (e.g.,
.bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics images
should not be imported into any word processing files that are uploaded.  Do not upload a
password-protected file.  The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly by
selecting the PDF filename in the rightmost column. The conversion process generally completes
within thirty minutes.  If you are unable to read this file after it has been converted, please do the
following:

1. Re-upload the attachment.

2. If the file still has not converted properly, then simplify the formatting of the file. 

For example, if you are using a Table structure in a WordPerfect document, remove the Table
structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

During the resubmission filing period, submitted applications may be updated and amended
multiple times until the filing deadline.

C. Reviewing FCC Form 175 Applications

Once the FCC has completed the 175 Review process, you can review FCC Form 175
applications electronically via the Internet.  Start your Netscape Web browser.  In your browser’s
Location field, enter http://wtbwww15.fcc.gov and then click 175 Review.
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D. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from
8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET.  All calls to the FCC Technical
Support Hotline are recorded.
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ATTACHMENT D

ACCESSING THE FCC NETWORK
TO FILE FCC FORM 175

This attachment describes how to access the FCC Network from a system that is running the
Microsoft Windows 95 or Microsoft Windows 98 operating system.  This involves configuring
dial-up network access and then performing the dial-up procedure. 

Note:  Dial-up access to the FCC Network is not required to submit or review FCC Form
175 applications.  You can perform those functions from the Internet, by entering location
http://wtbwww15.fcc.gov/ on your Netscape Web browser and clicking the 175 Submit
or 175 Review button, respectively.  For more details, refer to the Electronic Filing and
Review of the FCC Form 175 attachment.

Conventions

The instructions in this section use the following typographical conventions:

bold Represents objects on the screen that you click with the mouse pointer, including
buttons, Internet links, icons, tabs, menu items (e.g., Cancel button, Auctions
link, Save option in the File menu).

italic Represents field names or areas of a screen (e.g., Applicant field, Selected
Licenses area of a screen).

bold italic Represents characters that you must type exactly as they appear in the instructions.
 For example, if you are instructed to type http://wtbwww15.fcc.gov, you should
type all of the characters shown in bold italic exactly as they are printed.

SMALL CAPS Represents keys on the keyboard (e.g., ENTER, CTRL, ESC).

Note:  Throughout these instructions, “enter” means to type the appropriate information and then
press the ENTER key.

A. Accessing the FCC Network to Submit FCC Form 175 Applications

The following section provides the instructions for configuring the dial-up network access in
preparation for submitting FCC Form 175 applications.  The subsequent section gives the dial-up
procedure.
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1. Configuring Dial-Up Networking

1. To start dial-up networking:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking.

In Windows 98, click Communications, then Dial-Up Networking.

If Dial-Up Networking is not an option on your Accessories menu, you should install it
from your Windows 95/98 CD or diskettes.

2. When the Dial-Up Networking window appears, double-click the Make New
Connection icon. 

The Make New Connection window appears.

3. Type FCC Auctions 877# in the field titled Type a name for the computer you are
dialing. 

4. In Windows 95, click the down arrow at the right of the Select a modem field and select
your modem from the menu of available modems. 

In Windows 98, click the down arrow at the right of the Select a device field and select
your modem from the menu of available devices.

If your modem does not appear on this list, you must install your modem driver according
to the modem manufacturer installation procedures, which are usually described in your
modem’s user manual.

5. Click the Next button. 

6. Type 877 and 844-2788 in the Area Code and Telephone Number fields, respectively.

If you need to dial 9 or some other digit to get an outside line, include that digit in the
Area Code field.  For example, you might type 9, 1 877 in this field.

7. Verify that the correct country is selected in the Country code field. 

If necessary, click the down arrow at the right of the Country code field and select the
appropriate country from the menu of available countries.

8. Click the Next button.
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9. Click the Finish button. 

An icon labeled FCC Auctions 877# appears in the Dial-Up Networking window.

10. Verify that properties are configured correctly before attempting a dial-up session.  Put
the mouse pointer on the icon and click the right mouse button to display a menu.  Click
Properties from the menu.

11. Click the Configure button.  Click the Options tab at the top of the Properties window.

12. In the Connection control area of the Options tab, verify that neither option is selected.  If
either option is selected, click the check box at the left of the option to deselect it.  Then
click OK.

13. In Windows 95, click the Server Type... button.

In Windows 98, click the Server Types tab at the top of the Properties window.

14. In the Advanced Options area, verify that only Enable software compression is selected. 
If it is not selected, click the check box at the left of the option to select it.  If either of the
other options is selected, click the check box to deselect it.

15. In the Allowed Network Protocols area, verify that only TCP/IP is selected. 

If it is not selected, click the check box at the left of the option to select it.  If either of the
other options is selected, click the check box to deselect it.

16. Click the TCP/IP Settings button.  On the TCP/IP Settings window, select Server
assigned IP addresses at the top and select Specify name server addresses midway down
the window.

17. Type 165.135.79.95 as the Primary DNS and 165.135.241.149 as the Secondary DNS. 
Ensure that these two options are checked:

•  Use IP header compression
•  Use default gateway or remote network

18. Click OK on the TCP/IP Settings window and the Server Type window.

19. Close the Dial-Up Networking window.

20. a. Click the Windows 95/98 Start button, then click the Settings option to display the
Settings menu.

b. Click Control Panel and then double-click the Network icon.
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c. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP
protocols, highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears.  Read the information
on the dialog, then click the OK button.

d. Click the DNS Configuration tab and then click the Enable DNS radio button at the
top.

e. Type bidder in the Host box and type fcc.gov in the Domain box.

Note:  You are limited to three DNS entries. If you already have three DNS entries,
you must delete two of them before performing the next two steps.  To do this, click
the first entry you want to delete and click the Remove button.  Then click the second
entry you want to delete and click the Remove button again.

f. Type 165.135.79.95 in the DNS Server Search Order box and click the Add button.

g. Type 165.135.241.149 in the DNS Server Search Order box and click Add again.

h. Click OK on the TCP/IP Properties windows, then click OK on the Network
      windows.

 If you are prompted to restart your computer, click Yes to restart, then begin
the Dial-Up Procedure.

2. Dial-Up Procedure

1. If the Dial-Up Networking window is not currently open, do the following:

a. Click the Windows 95/98 Start button. 
b. Click the Programs option to display the Programs menu.
c. Click the Accessories option to display the Accessories menu.
d. In Windows 95, click Dial-Up Networking

In Windows 98, click Communications, then Dial-Up Networking. 

The Dial-Up Networking window appears. 

2. In the Dial-Up Networking window, double-click the FCC Auctions 877# icon.

3. Click the Connect button on the window.  Do not enter User name or Password.
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The Connection window appears, indicating the status of your connection as your modem
dials into the system.  This window must remain running during your dial-up session.  You
may minimize the window, if you wish.

If your modem fails to establish a connection, please see the Troubleshooting section.

B. Submitting FCC Form 175 Applications

After you have connected to the FCC Network, start your Netscape Web browser.  In your
browser’s Location field, enter http://wtbwww15.fcc.gov (primary location) or
http://wtbwww34.fcc.gov (secondary location) and then click 175 Submit.

Note:  The wtbwww34 location can only be accessed through dial-up networking; it
cannot be accessed through the Internet.

When uploading attachments in FCC Form 175 Submission, applicants may use a variety of file
formats -- including Word 97 or earlier, WordPerfect 6.x or earlier, Adobe PDF, and ASCII text -
- and should verify that the files contain all exhibit information.  Graphics file uploads (e.g.,
.bmp, .tiff, .jpg) and spreadsheets (e.g., Excel, Lotus) are not supported, and graphics images
should not be imported into any word processing files that are uploaded.  Do not upload a
password-protected file.  The FCC system will not be able to open it or convert it.

After you upload an attachment and it has been converted, check to see if it converted properly
by selecting the PDF filename in the rightmost column. The conversion process generally
completes within thirty minutes.  If you are unable to read this file after it has been converted,
please do the following:

1. Re-upload the attachment.

2. If the file still has not converted properly, then simplify the formatting of the file. 

For example, if you are using a Table structure in a WordPerfect document, remove the Table
structure and leave the contents of the table, then re-upload the attachment.

After you have successfully re-uploaded an attachment, please delete the old, unreadable
attachment files.

During the resubmission filing period, submitted applications may be updated and amended multiple
times until the filing deadline.

When you have finished, exit your Web browser; then click the Disconnect button on the
Connection window to end your dial-up session.
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C. Removing the Dial-Up Networking Service

Once you have finished using the dial-up networking service, you can remove it from your
computer, as follows:

1. Click the Windows 95/98 Start button, then click the Settings option to display the Settings
menu.

2. Click Control Panel and then double-click the Network icon.

3. Highlight the TCP/IP Protocol and click Properties.  If there are multiple TCP/IP protocols,
highlight TCP/IP --> Dial-Up Adapter and click Properties.

In a Windows 98 environment, a confirmation dialog appears.  Read the information on the
dialog, then click the OK button.

4. Click the DNS Configuration tab.

5. Click the DNS Server Search Order box containing 165.135.79.95 to select it, then click the
Remove button.

6. Similarly, click the DNS Server Search Order box containing 165.135.241.149 to select it,
then click the Remove button.

7. Click OK on the TCP/IP Properties windows, then click OK on the Network windows.

8. If you are prompted to restart your computer, click Yes to restart.

9. Remove the FCC Auctions 877# icon from your desktop.  That is, click the icon with your
right mouse button and then click the Delete option in the pull-down menu.

D. Troubleshooting

Following are problems you may encounter and possible solutions for resolving or isolating
them.

1. Modem does not respond

1. Confirm that all physical connections for the modem are present.

2. Confirm that the phone line is active by connecting it to a telephone and checking for a dial-
tone.

3. Confirm that the correct modem driver is installed for your modem.
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2. Modem dials but does not connect

1. Confirm that the number the modem is dialing is correct.

2. Confirm that the modem prefix, if any, is correct.

Using a Backup Dial-In Number.  If the number and prefix are correct, the 877 number being
dialed may be experiencing problems.  In this case, you can reconfigure the dial-up software
using an alternate dial-in number, which is also toll-free.  To use the backup number, perform the
Configuring Dial-Up Networking procedure again, but this time make the following changes:

•  In Step 3, type FCC Auctions 800# in the field titled Type a name for the computer you are
dialing.

•  In Step 6, type 800 and 378-7435 in the Area Code and Telephone Number fields,
respectively.

•  In Step 17, type 165.135.241.149 as the Primary DNS.

•  In Step 20f, type 165.135.241.149 in the DNS Server Search Order box.

3. Modem dials and connects, but nothing appears when you enter the Location in the
Web browser 

1. Verify the Dial-Up Networking settings specified in the Configuring Dial-Up Networking
section.

2. Confirm that your Web browser is not using proxies:

a) On your browser, click the Preferences option in the Edit menu.
b) In the Category area at the left, double-click Advanced.
c) Click the Advanced structure’s Proxies option.
d) Click the radio button labeled Direct connection to the Internet.
e) Click the OK button at the bottom of the window.

4. Receive an Internal Server error in the Web browser

1. Confirm that the Location is set to http://wtbwww15.fcc.gov or http://wtbwww34.fcc.gov

2. On your browser, click the Preferences option in the Edit menu.  In the Category area at the
left, double-click Advanced.  In the area at the top, confirm that Enable Java and Enable
JavaScript are selected.  In the Cookies area, confirm that Accept all cookies is selected.
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E. Help

For technical assistance with installing or using FCC software, contact the FCC Technical
Support Hotline at (202) 414-1250 (V) or (202) 414-1255 (TTY).  The FCC Technical Support
Hotline is generally available Monday through Friday from 7 a.m. to 10 p.m. ET, Saturday from
8 a.m. to 7 p.m. ET, and Sunday from 12 p.m. to 6 p.m. ET.  All calls to the FCC Technical
Support Hotline are recorded.
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